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Release Note 01 
GEM WordChart™ Manual 
First Edition, January 1986 

Modifying Wordcharts with GEM Draw™ Version 1.2 or Earlier 

Note: The following information applies only if you have GEM Draw, 
version 1.2 or earlier. 

When you bring a wordchart into your version of GEM Draw (bringing a 
wordchart into GEM Draw is described in Appendix A of the manual), the 
letters in each line of text will appear to be overlapping each other. 

To make the text look the way it should, do this: 

1. Select a line of text. If you have several lines of text with the same 
attributes, you can select them all at once, either by dragging a 
rubber rectangle around them or by Shift-clicking. 

2. Display the Font Menu. 

3. Click on the text's correct size. For example, if you have selected 
one or more lines of 20-point text, click on 20 point in the Font 
Menu. This causes GEM Draw to redraw the text line (or lines) 
without the characters overlapping. 

4. When you have redrawn all the text in this manner, save the GEM 
Draw version of your wordchart, as described in Appendix A. 

End of Release Note 

Copyright © 1986 Digital Research Inc. All rights reserved. GEM, GEM Draw and GEM 
WordChart are trademarks of Digital Research Inc. 





Foreword 

Welcome to GEM WordChart™--the quick, easy, and fun 
way to create presentation-quality text charts (or 
"wordcharts"). 

Using GEM WordChart is simple. You work directly on a 
screen that shows you what your final wordchart will look 
like; you don't use cryptic commands and codes. With 
GEM WordChart, creating a wordchart is basically a two 
step process: 

1. You choose a "template" that tells GEM WordChart 
how you want your finished wordchart to look. {A 
template is an empty wordchart form with rows and 
columns for text.} 

2. You type the text you want in your wordchart in a "fill
in-the-blanks" fashion. 

GEM WordChart comes with standard templates for 
wordcharts with one or more columns, for "free-form" 
wordcharts, and for outlines. You can use them 
unchanged, or you can adapt them to your own needs. 

If you have a color printer, camera, or plotter, GEM 
WordChart lets you produce color wordcharts even if you 
don't have a color monitor. 

You can place a border around your wordchart by 
choosing one of the borders GEM WordChart provides, or 
you can create your own custom borders, if you have GEM 
Draw™ from Digital Research®. 
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Your GEM WordChart guide is divided into five sections 
and three appendixes. 

• Section 1 explains how you "install" GEM WordChart on 
your computer and how you start GEM WordChart. 
You must install GEM WordChart before you use it. 

• Section 2 describes the GEM WordChart screen and 
what you see as you use the program. 

• Section 3 is a brief tutorial. After you complete the 
tutorial, you'll be ready to use GEM WordChart to 
create wordcharts with your own personal touch. 

• Section 4 is a detailed reference section, including 
descriptions of the menus and other features. 

• Section 5 describes the Item Selector, a special tool 
for naming, saving, and opening wordcharts, and for 
using templates and borders. 

• Appendix A describes how you can modify your 
wordcharts with GEM Draw. 

• Appendix B explains the backup documents GEM 
WordChart creates, those with the document type BAK. 

• Appendix C describes some of the special 
characteristics of plotters and how they can affect 
your wordchart output. 

When you complete the tutorial, you can experiment with 
GEM WordChart on your own. Try to use all of the 
features described in the tutorial and in Sections 4 and 5. 
Don't be afraid to try new things, even if they aren't 
discussed in this guide. 

Note: All the illustrations in this manual were produced 
with GEM ™ software: GEM WordChart, GEM Draw, or GEM 
PaineM

• 
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SECTION 1 

Getting Started 

If you haven't done so already, read your GEM DesktopTM 
manual and become familiar with the basic GEM Desktop 
techniques, many of which you will uSe with GEM 
WordChart. 

Here's a quick refresher on the basic mouse techniques 
you'll use: 

click Press and release the mouse button once. 

double-click Press and release the mouse button twice 
in rapid succession. 

1. Press and hold down the mouse button. 
2. Move the mouse. 
3. Release the mouse button. 

Remember, always use the left mouse button. 

BACKING UP YOUR GEM WORDCHART MASTER DISK 

Before you install GEM WordChart on your computer, make 
a backup copy of your GEM WordChart Master Disk. 
(Formatting and copying disks are described in the GEM 
Desktop manuaL) 

1. Start the GEM Desktop on your computer. 

2. Format a flo.p.P¥ disk. Give the disk this name: 

GEM WordChart COpy 

1-1 



Backing Up Your GEM WordChart Master Disk GEM WordChart 

3. Copy the contents of the GEM WordChart Master Disk 
to the GEM WordChart COpy disk.· 

4. Store your GEM WordChart Master Disk in a safe place 
and use the COpy disk for installing GEM WordChart 
on your hard disk or on floppy disks. 

If you are going to run GEM WordChart from floppy disks, 
format two more floppy disks at this time. Give the disks 
these names: 

GEM WordChart APPLICATION Disk 
GEM WordChart DATA Disk 

Set both disks aside for the time being. 

INSTALLING GEM WORDCHART 

INSTALL.APP 

1-2 

Before you use GEM WordChart, you must install it on 
your hard disk or on floppy disks. The GEM WordChart 
COpy disk contains a program called INSTALL.APP that 
creates folders and organizes your GEM WordChart 
software on your hard disk or on floppy disks. You only 
need to run INSTALL.APP one time. 

To run INSTALL.APP, start the GEM Desktop and then 
follow these steps: 

1. Insert the GEM WordChart COpy disk into drive A and 
open the drive A floppy disk icon. 

2. Locate the icon called INSTALL.APP. 

3. Double-click on the INSTALL.APP icon. This starts the 
INSTALL.APP program. 

4. Follow the instructions in INSTALL.APP for installing 
GEM WordChart on your hard disk or floppy disks. 



GEM WordChart Installing GEM WordChart 

GEt·1APPS 

~·~CHAF:.TS 

If you are. installing on floppy disks, you'll need the two 
disks you formatted: GEM WordChart APPLICATION Disk 
and GEM WordChart DATA Disk. 

INSTALL.APP copies GEM WordChart to your GEMAPPS 
folder. In a hard disk system, GEMAPPS is in the hard 
disk's "root" (initial) directory. In a floppy disk system, 
GEMAPPS is in the root directory of the GEM WordChart 
APPLICATION Disk. The icons for the GEM WordChart 
software have the following names: 

• WORDCHRT.APP 
• WRDCHTHI.RSC 
• WRDCHTLO.RSC 

INSTALL.APP also creates two folders, WCHARTS and 
BORDERS. WCHARTS is where GEM WordChart stores the 
wordcharts you create; BORDERS is where you keep the 
borders for your wordcharts. INSTALL.APP places these 
folders in the following locations: 

WCHARTS 

BORDERS 

in the root directory of your hard disk 
or, in a floppy disk system, the root 
directory of the GEM WordChart DATA 
Disk 

inside the GEMAPPS folder 

At the conclusion of INSTALL.APP, you see a dialog 
informing you that GEM WordChart is now installed and 
ready to run. 

Before continuing, put your GEM WordChart COpy disk in 
a safe place, just as you did with the GEM WordChart 
Master Disk. You don't need either for your daily GEM 
WordChart work. 
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STARTING GEM WORDCHART FROM A HARD DISK 

To start GEM WordChart from a hard disk, start the GEM 
Desktop and then follow these steps: 

1. Open the hard disk icon to its root directory. 

2. Find the GEMAPPS folder and double-click on it. 

3. Locate the WORDCHRT.APP icon in the GEMAPPS 
directory and then do either of the following: 

'""0 F:.O C H F:. T - ~ F' F' • Double-click on the WORDCHRT.APP icon. 

• Select the WORDCHRT.APPicon and then choose 
the Open command from the File Menu. 

STARTING GEM WORDCHART FROM FLOPPY DISKS 

To start GEM WordChart from a floppy disk, start the GEM 
Desktop and then follow these steps: 

1. Remove the GEM DESKTOP disk from drive A. 

2. Insert your GEM WordChart APPLICATION Disk into 
drive A. 

3. Insert your GEM WordChart DATA disk into drive B. 

4. Open the drive A floppy disk icon. (If it is already 
open, press the Esc key to update the directory.) 

5. Double-click on the GEMAPPS folder in the A:\ window. 

6. Locate the WORDCHRT.APP icon in the A:\GEMAPPS 
directory and then do either of the following: 

~~OF' .. OCHF:.T - ~F'F' • Double-click on the WORDCHRT.APP icon. 

1-4 

• Select the WORDCHRT.APP icon and then choose 
the Open command from the File Menu. 
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STARTING DIRECTLY TO A WORDCHART 

It's likely that you'll often want to start GEM WordChart 
and immediately begin revising or updating a wordchart 
you have previously saved. In that case, use this shortcut 
method of starting GEM WordChart: 

1. Start the GEM Desktop. 

2. Find the folder called WCHARTS. 

(Remember, it is either in the root directory of your 
hard disk or in the root directory of the GEM 
WordChart DATA Disk, which should be in drive B.) 

3. Open the WCHARTS folder and find the icon for the 
wordchart you want. (All wordchart documents have 

EX~t-1PLE _ ~'~CH the type WCH, as shown at the left.) 

4. To start GEM WordChart, do either of the following: 

• Double-click on the wordchart's WCH icon. 

• Select the wordchart's WCH icon and then choose 
the Open command from the File Menu. 

End of Section 1 
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SECTION 2 

GEM WordChart Screen 

menu bar 

File! Edit 

The illustration below shows what GEM WordChart looks 
like when it first appears on your screen. (The names of 
the text zones--"TITLE ZONE," for example--do not 
actually appear on the screen. They are included here for 
identification only.) 

~--- margin indicators----.... 
title bar t 

[IJ. II II ~----~r--------'--'ij 
II II a II m]iiiiiii;iiiiii!iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii":iii:iii:iililililil TITLE ZONEli:iiiii \i!i::iiiiiiii'''iii!.iiiiiiiiiiiii!iii!iii!'ii[ 

ODC>1!f' ..... ,/ 

... Swiss 
Dutch 

Nopr~al 

... Bold 

... Italic 

toolkit pointer text fields/rows ---- slider/ 
scroll bar 
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Note: The appearance of the GEM WordChart screen can 
vary somewhat. With some versions of the GEM Desktop, 
the GEM WordChart menu bar is different. See Section 4 
for an explanation of these variations. 

GEM WORDCHART SCREEN COMPONENTS 

Menu Bar 

Title Bar 
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The menu bar contains the names of GEM WordChart's 
menus. You display menus and choose commands just as 
you do on the GEM Desktop. When you touch a menu's 
name with the pointer, the menu drops down. By clicking 
with the mouse, you can choose commands to create, 
modify, and save your wordcharts. 

The menu commands are described in Section 4. 

The title bar identifies the wordchart on your screen and 
tells where it is located. The title bar provides this 
information in the following manner: 

disk drive identifier folder (directory) name wordchart name and type 

L C:\WCH~RTS\PROMO.WCH ~ 
In this example, a wordchart called PROMO.WCH is in the 
WCHARTS folder on your hard disk C:\. (In some systems, 
the hard disk might have a different drive identifier.) 

See the GEM Desktop manual or your operating system 
manual for more information about directory names and 
disk drive identifiers. 
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Until you save it, a wordchart is called UNTITLED.WCH. 
After you name and save your wordchart, its name 
appears in the title bar, followed by a dot (.) and the type 
WCH. For example, if you name a wordchart MYCHART, it 
becomes MYCHART.WCH. 

Ruler and Margin Indicators 

The ruler measures the horizontal dimension of your 
wordchart page, and the margin indicators show your 
current margin settings. 

To change the left or right margin, drag the left or right 
margin indicator to the position you want. 

Note: When moving a margin, place the tip of the pOinter 
directly on top of its margin indicator, and press the 
mouse button. Don't begin dragging until the pointing 
finger icon appears (see left). 

Text Fields, Text Rows, and Text Zones 

The major components of a wordchart template are text 
fields, text rows, and text zones. 

"Text fields" are the shaded rectangles into which you 
type the contents of your wordchart. 

A "text row" is a group of one or more text fields that 
appear on the same line of a template. For example, in a 
two-column wordchart a row can contain two text fields. 
(See "Using Multi-Column Templates" in Section 4.) In the 
template illustrated on page 2-1, however, each row 
contains a single text field. 

"Text zones" are the four divisions of a wordchart 
template: title, column head, text body, and footer. Each 
zone has its initial set of "attributes" (characteristics), like 
text size, style, and alignment. For example, in a two-
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column template the zones have these initial attributes: 

title 36-point bold italic type, one text row, centered 
text. 

column 
head 

text 
body 

Maximum number of rows: 2 

28-point bold type, one text row with two te){t 
fields, centered text. 
Maximum number of rows: 1 

20-point normal type, eight text rows with two 
text fields per row, left-aligned text. 
Maximum number of rows: 26 

20-point italic type, one text row, centered text. 
Maximum number of rows: 2 

Point sizes are described under "Changing Text Size" in 
Section 4. 

You can change any of these attributes by selecting from 
the toolkit, which is described later in this section. You 
can also insert and delete rows in a zone, but you can't 
add more rows than its maximum allows. 

Note: In a two-row title zone or footer, you can select the 
rows individually and give them their own attributes. 

Text Cursor and Active Text Zone 

2-4 

The text cursor (a vertical blinking bar) shows where the 
characters you type will appear. 

The zone in which the cursor is located is the "active" text 
zone. (In a multi-column format, only one column in a 
zone can be active at a time.) The active zone is 
identified by squares called "select boxes" at its corners. 
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Selecting a Text Zone 

By moving the cursor from one zone to another, you 
select a new zone. The new zone becomes the active 
zone, the select boxes appear at its corners, and the 
toolkit changes to show its attributes. 

To select a zone, you can use any of the cursor 
techniques described next. 

Moving the Text Cursor 

To move the text cursor, you can do any of the following: 

• Move the pointer to a text field and click. If there is 
text in the field, you can place the cursor anywhere in 

~ tWSajtJ • 

the text. 

Use the up- or down-arrow keys (on your keypad) to 
move to the field above or below. 

Use the left- or right-arrow keys to move one 
character to the left or right. 

Press the Tab key to move to the next field. 

• Press Shift-Tab to move to the previous 
field. 

!Ell · Press the Enter key to move down a text field. 
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Toolkit 

GEM WordChart also uses what is sometimes referred to 
as the "keyboard control diamond," a feature of a popular 
word processing program. Hold down the Ctrl key and 
then press a letter key to move the text cursor within a 
field or to other fields, as follows: 

- to same position in field above 

181 CJ' " 

. .... ... . . 
': elrl :::::::: + :: S :: 
::'::}" .}:::',: :::. -::: - one character to the left 

- one character to the right 

- to same position in field below 

The toolkit shows the settings for the attributes of your 
active text zone: text color, bullet style, text style, text 
size, text alignment, and font. The current settings for 
color and bullets are surrounded by a square; the 
remaining settings in the toolkit are indicated by a marker. 

By selecting from the toolkit, you can change the text 
zone's attributes. The individual components of the toolkit 
are described in detail in Section 4. 

Zone Markers 
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You can replace the toolkit with the "zone markers," which 
define the upper and lower boundaries of each text zone. 
The zone markers are described in Section 4. 

Using the zone markers, you can make text zones larger 
or smaller, and you can move text rows up or down in 
their zones. 



GEM WordChart GEM WordChart Screen Components 

Pointer 

GEM WordChart uses the same arrow mouse pointer the 
GEM Desktop uses. The pOinter moves on the screen 
when you move the mouse or press the arrow keys. (If 
the arrow keys do not move the pointer, press the Ctrl key 
once and then use the arrow keys.) 

The pOinter disappears from the screen when you type at 
the keyboard. It reappears when you move the mouse or 
press any of the arrow keys. 

Slider and Scroll Bar 

At times you might not be able to see the bottom or top 
of your wordchart template on the screen. For example, in 
Portrait format (described in Section 4), the footer zone is 
not initially visible. 

To move part of a wordchart into view, drag the slider up 
or down. The GEM WordChart slider works in exactly the 
same manner as a slider in a GEM Desktop window. 

You can also move the wordchart by clicking on the scroll 
bar. The scroll bar also works in the same manner as its 
counterpart in a GEM Desktop window. 

End of Section 2 
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Section 3 

TUTORIAL 
The tutorial teaches you: 

How to enter text 

How to save a wordchart on disk 

How to change and correct text 

How to change text attributes 

How to add bullets 

How to include one of the borders 
provided with GEM WordChart 

How to use an existing template 

... and more 

Then you can create your own wordcharts. 





SECTION 3 

Tutorial 

The wordchart you create with this tutorial is shown in 
the divider at the beginning of this section. (All section 
dividers in this guide were created using GEM WordChart.) 
After you create the wordchart, you'll learn how to make 
changes to it. 

Note: This tutorial assumes you have a mouse or other 
pointing device attached to your computer. If you do not 
have a mouse, refer to the GEM Desktop manual to learn 
how to move the pointer with the keyboard. 

STARTING GEM WORDCHART 

If GEM WordChart is not already running on your 
computer, start it now. Starting GEM WordChart is 
described in detail in Section 1. 

When the GEM WordChart screen first appears, you see an 
empty wordchart template called UNTITLED.WCH. 

ENTERING TEXT IN YOUR WORDCHART 

Entering text in a wordchart is simply a matter of typing; 
the words you type appear wherever the text cursor is 
currently located. 

3-1 



Entering Text in Your Wordchart GEM WordChart 

@J BEl 
IIElaa 

... Swiss 
Dutch 

Normal 
... Bold 

Italic 
Underline 

left 
... Center 

Right 
!)t.~e.il'li.\l 

When you begin, the text cursor is in the topmost text 
field, the "title zone" described in Section 2. Type the 
following word: 

TUTORIAL 

If you make a typing error, press the Backspace key to 
erase, and then retype. 

Move the pointer down to the next text field (the column 
head) and click the mouse button. Note the following: 

• The text cursor is now in the column head field. 

• The select boxes identify the column head as the 
active zone. 

• The margin indicators have moved. 

Look at the toolkit on the left side of your 
screen. The toolkit shows you that the text you 
enter in this field will have the following 
attributes: 

Color code 
Bullet 
Font 
Text style 
Text size 
Text alignment 

1 (black) 
none (an empty box) 
Swiss 
Bold 
28 
Center 

(You'll learn more about these attributes later, 
so don't worry about them now.) 

Type the following words for the column head: 

The tutorial teaches you: 
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Now move the pointer down and select the first field of 
the text body. The active text zone is now a group of 
eight text fields rather than just one. This tells you that all 
eight text fields have the attributes shown in the toolkit. 

In the first field of the text body, type the following: 

How to enter text 

Press the Enter key. The text cursor moves down to the 
next text field. Type the following lines and press the 
Enter key at the end of each line: 

How to save a wordchart on disk 

How to change and correct text 

How to change text attributes 

How to add bullets 

Type the next line as a continuous sentence; don't press 
the Enter key until after "GEM WordChart": 

How to include one of the borders 
provided with GEM WordChart 

Note that, because the sentence is longer than the field, 
GEM WordChart's "word wrap" feature automatically 
extends the field, continuing it on another line. 

Now type the last two lines of the text body: 

How to use an existing template 

... and more 

Press the Enter key to move the text cursor to the 

3-3 



Entering Text in Your Wordchart GEM WordChart 

template's last text zone, the footer. The text attributes 
have changed again: the text is the same size as in the 
text body, but it is centered and italic. To complete this 
wordchart, type the following: 

Then you can create your own wordcharts. 

SAVING YOUR WORDCHART ON DISK 

To save your wordchart on disk, do the following: 

1. Move the pointer to the menu bar and display the File 
Menu. 

2. Choose the Save as ... command. The Item Selector 
appears on your screen. 

3. Type a name for the wordchart you are saving, such as 
TUTOR 1. Then press the Enter key or click on the OK 
exit button. 

After a few seconds, GEM WordChart returns to the point 
where you chose the Save as ... command. Your 
wordchart is still on the screen and its name now appears 
in the title bar. (Note that GEM WordChart has appended 
the WCH type to the name you provided.) 

Item Types: WCH and GEM 
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When you save your wordchart, GEM WordChart actually. 
saves two versions of it, one with the type WCH and the 
other with the type GEM. 

For example, if you named your tutorial wordchart 
TUTOR1, GEM WordChart saves TUTOR1.WCH and 
TUTOR1.GEM, both in the WCHARTS folder. GEM 
WordChart also changes the name in the title bar from 
UNTITLED.WCH to TUTOR 1.WCH. 
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TUTOR 1 _ ~'KH 

~ 
TU TO R 1 _ Ij E t·1 

You can't use these two versions interchangeably; each 
has its own purpose: 

WCH 

GEM 

Use this version with GEM WordChart. For 
examJi>le, if you want to start directly to a 
wordchart (as described in Section 1), make sure 
you double-click on the WCH version. 

Use this version with GEM Output (as described 
under "Printing Your Wordchart," later in this 
section) or with GEM Draw. Appendix A 
describes how you modify wordcharts with GEM 
Draw. 

CORRECTING AND EDITING TEXT 

Shortcuts 

To correct typing errors or edit your text, move the cursor 
to the point at which you want to make the change. 
Moving the cursor is described in Section 2. 

To erase the character to the left of the cursor, use the 
Backspace key. To erase the character to the right of the 
cursor, use the Delete key. 

To delete the word to the right of the text cursor~ hold 
down the Shift key as you press the Delete key. 

To delete the contents of an entire text field, use the Esc 
(Escape) key. 

To help you remember how to delete characters, words, 
and the contents of text fields, GEM WordChart displays a 
summary of the techniques when you choose the 
Shortcuts ... command from the Options Menu. 

3-5 



What's Next? GEM WordChart 

WHAT'S NEXT? 

You have just created your first wordchart and stored it 
on disk. You'll find creating other wordcharts with GEM 
WordChart just this simple and easy. 

Now you'll learn how to modify your wordchart and how 
to use some of GEM WordChart's other features. 

CHANGING TEXT ATTRIBUTES 

... Normal 
Bold 
Italic 

Underline 

14 
~ 20 

28 
36 
72 
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Your next step is to change the attributes of some of the 
text fields in the wordchart you just created. 

Click on the wordchart's title ("TUTORIAl"). Note its 
attributes in the toolkit. To change the text style 
attribute from Bold Italic to Normal, move the pointer 
to the text styles in the toolkit and click on the word 
Normal. As soon as you click, GEM WordChart 
changes the title's text style on your screen and moves 
the marker in the toolkit. 

Now select the column head and note its attributes in the 
toolkit. Change the text size from 28 to 20 by clicking on 
20 in the text sizes. As before, the text changes and the 
marker moves. 

Finally, change the column head from Swiss font to Dutch 
font by clicking on Dutch in the toolkit, and then underline 
the column head by clicking on Underline. 
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ADDING BULLETS TO YOUR WORDCHART 

Move the pointer and select a field in the text body. 

Now go to the bullets in the toolkit and click on the solid 
check mark. Check marks appear to the left of all eight 
text fields. 

DELETING A ROW FROM YOUR WORDCHART 

Move the pointer and select the last field of the text body, 
the one that says " ... and more." 

Display the Edit Menu and choose the Delete Row 
command. The text row disappears from your screen. 

SAVING A NEW VERSION OF YOUR WORDCHART 

After you change your wordchart, you might want to save 
the new version and still keep the original TUTOR 1.WCH. 
To do so, take the following steps: 

1. Choose the Save as ... command from the File Menu. 

2. When the Item Selector appears, type a name for the 
new version of your wordchart, such as TUTOR2. 

3. Press the Enter key or click on the OK exit button. 

PRINTING YOUR WORDCHART 

To print the wordchart you just saved, choose the To 
Output command from the File Menu. This starts the 
GEM OUTPUT program. 

The first things you see in OUTPUT are an "output list" 
with the name of your wordchart (note that OUTPUT uses 
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the version with the GEM document type) and the START 
OUTPUT dialog with "Printer" highlighted. To send your 
wordchart to your printer, simply click on the OK button or 
press the Enter key. 

You can also use OUTPUT to produce output on plotters, 
the screen, and cameras. See the GEM Desktop manual 
for a description of how you use these devices. 

When OUTPUT has finished printing your wordchart, 
display the File Menu and choose the Quit command. 
This returns you to GEM WordChart, with your wordchart 
(TUTOR2) on the screen. 

ADDING A BORDER TO YOUR WORDCHART 
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To add a decorative border to your wordchart, follow 
these steps: 

1. Make sure TUTOR2.WCH is your current wordchart. 

if it is not, display the File Menu and choose the 
Open ... command. The Item Selector appears with the 
names of your wordcharts. Double-click on 
TUTOR2.WCH. 

2. Display the Edit Menu and choose the Get Border ... 
command. The Item Selector appears again; it now 
contains the names of your borders. 

3. Type SAMPlE-L.GEM and then press the Enter key. 
The border appears on the screen, with the text of 
TUTOR2.WCH inside it. 

(Typing the border name is another way of selecting 
from the Item Selector. For a full description of how 
you use the Item Selector, see Section 5.) 
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4. Save the wordchart with its border. You can do either 
of the following: 

• To save it under its current name, display the File 
Menu and choose the Save command. 

• To save it under a new name, choose the Save as ... 
command. When the Item Selector appears, type 
the new name and then press the Enter key. 

Sometimes you might have to adjust the size or 
proportions of your wordchart to fit a border. "Modifying 
a Wordchart to Fit a Border," in Section 4, describes how 
you do this. 

If you decide you don't want your wordchart to have a 
border after all, choose the Remove Border command 
from the Edit Menu. 

USING EXISTING TEMPLATES 

Every time you save a wordchart, whether or not you have 
changed its original set of attributes, GEM WordChart 
saves its template. Each saved template has the following 
attributes: 

• margin settings for each text zone 
• all zone attributes from the toolkit 
• border (if any) 
• any lines or boxes in the text zones 

You can use the template from any saved wordchart to 
create other wordcharts with the same attributes. To use 
a template (we'll use the one you just saved as an 
example), do the following: 
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1. Display the File Menu and choose the New command. 
This clears the text of your wordchart off the screen. 

This step is mandatory. The Use Template from ... 
command (see the next step) is not available if there is 
text in the template on the screen. 

2. Display the Template Menu and choose the Use 
Template from ... command. 

3. When the Item Selector appears, double-click on the 
name of the wordchart you just saved. 

GEM WordChart displays the wordchart template minus 
text. (If you've fol0wed the tutorial so far, the template 
should have a border, the text body should have check 
marks, and the footer should be missing.) Now you can 
begin to create a new wordchart with this template. 

AFTER THE TUTORIAL 
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This completes the tutorial. We recommend you read the 
remainder of your GEM WordChart guide and spend time 
experimenting with the menu commands, toolkit, and other 
features until you feel comfortable with them. 

To stop GEM WordChart and return to the GEM Desktop, 
choose the Quit command from the File Menu. 

End of Section 3 
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SECTION 4 

GEM WordChart Reference 

This section contains detailed reference information about 
the GEM WordChart menus, commands, toolkit, and other 
features. 

MENUS AND COMMANDS 

Descriptions of the menus and their commands appear on 
the following pages. 

The menus include a "keystroke equivalent" of each 
command. These keystroke equivalents are described on 
page 4-7. 

Variations in the Menu Bar 

If you use GEM WordChart with certain versions of the 
GEM Desktop, the WORDCHRT Menu is called the Desk 
Menu and appears at the left side of the menu bar. 
Differences in name and location notwithstanding, they are 
the same menu. 
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File Menu 

FILE MENU 

New 
Open ... 

Save AV 
Save as... AM 
Abandon AA 

To Output AU 
Quit AQ 
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GEM WordChart 

Starts a new wordchart. Removes all 
text from your current wordchart but 
retains current template. Name in 
title bar becomes UNTITLED.WCH. 

Displays Item Selector so you can 
select an existing wordchart. 

Saves your current wordchart on disk 
under the name shown in its title bar. 

Displays Item Selector so you can 
save your current wordchart on disk 
under a new or different name. 

Discards all changes to the current 
wordchart. The last saved version of 
the wordchart returns to your screen. 

Reproduces your wordchart(s) on an 
output device, such as a printer. See 
the description of the GEM OUTPUT 
program in your GEM Desktop manual. 

Stops GEM WordChart and returns 
you to the GEM Desktop. 



GEM WordChart Edit Menu 

EDIT MENU 

inserted immediately above the one in ~
AddS a row (line) to the wordchart 
template on your screen. The row is 

",.illiiillilL ____ ---~--. which the text cursor is located and 
Insert Row AN has the same attributes. 

Delete Row Ay 

Get Border ... 
Remove Border 

- Deletes the row in which the text 
cursor is located. 

~ O;splays Item Selector so you can 
~ select a border for your wordchart. 

Removes the border you included with 
the Get Border ... command. 

Note: If you delete the last or only row of any zone, you 
cannot restore the zone. For example, if you totally delete 
the title, you can't use the Insert Row command to put 
the title row back in. Instead, you have to abandon your 
changes and start over again. Be particularly careful when 
deleting the title, column heads, and footer, which are only 
a single row. 

In a multi-column format, inserting or deleting a row 
affects all the fields in that row. For example, if you 
delete a row in the text body of a three-column template, 
you delete the three text fields that make up the row. 
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TEMPLATE MENU 

~
DiSPlayS Item Selector so you can use 

~1iiI~iIiiiI~ __ -::-____ -=-:::'--, an existing wordchart's template to 

Use Template from... AT create another wordchart. 

Remember Template AR 
Template Gallery... AG 
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-----Replaces a template in the gallery 
"-- with the template on the screen. 

~DiSPlayS the template gallery so you 
can select a template. 



GEM WordChart Options Menu 

OPTIONS MENU 

~ 
Chooses a Portrait (vertical) page 
layout. 

~.IiI~JI.1L"'iiliil·iIII'1"lIIik"" _______ -::---...... /" ~ Chooses a Landscape (horizontal) 

Portrait Ap ~ page layout. 

~ landscape A l 
........................................................................ ~ Places a box around each field in the 

l · & B AZ ______ active zone; places a line above or 
~nes oxes · · · below each field. 

Numbers & letters AK . 
Zone Markers AJ ---------ChangeS from bullets to numbers and 

--;~:;;::;;~~~-------:~- '-.........~'etters in the toolkit. 

............ ~ Displays the zone markers in place of 
the toolkit . 

• IJ 11 ... III ilk.... Displays a dialog showing text editing 

Portrait 
~ landscape 

techniques for GEM' WordChart. 

lines & Boxes ... 
Bullets 

_Changes from numbers and letters to 
bullets in the toolkit. 

Toolkit 

Shortcuts ... 
-Displays the toolkit in place of the 

zone markers. 

The fourth command in the Options Menu is either 
Numbers & Letters or Bullets, depending on the current 
state of the toolkit. See "Adding Bullets, Numbers, or 
Letters" later in this section. 

The next command is either Zone Markers or Toolkit, 
depending on the current state of the GEM WordChart 
screen. See "Using the Zone Markers" later in this ~ection. 
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WORDCHRT MENU 

~JordChart 

Desk Accessory 
Desk Accessory 
Desk Accessory 
Desk Accessory 
Desk Accessory 
Desk Accessory 

GEM WordChart 

__ ------Displays a dialog box showing 
information about GEM WordChart, 
including its version number. 

--------Names of the desk accessories 
installed by your GEM software. To 
start a desk accessory, click on its 
name in the menu. 

Note: You can only run desk accessories on your 
computer if it has at least 320 kilobytes of Random 
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Access Memory (320K RAM). If it has less than this 
amount, desk accessory names do not appear in the menu. 
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KEYSTROKE EQUIVALENTS OF MENU COMMANDS 

Commands in the File, Edit, Template, and Options Me.nus 
each have a "keystroke equivalent," a shortcut method of 
choosing the command. The keystroke equivalents appear 
on the right side of the menus. You can choose a 
command in either of two ways: by displaying a menu and 
clicking on the command with the pointer or by using the 
keystroke equivalent. 

The notation in the menus uses a caret ("') to represent 
your keyboard's Ctrl key. For example, the keystroke 
equivalent for the New command in the File Menu is A W. 
This means you hold down the Ctrl key while you type the 
letter W, in upper or lower case. 

The table on the next page lists the GEM WordChart 
commands (in alphabetical order), their keystroke 
equivalents, and the menus in which the commands 
appear. 

Note: If a command is currently unavailable (dimmed), its 
keystroke equivalent has no effect. 
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Keystroke Equivalents of Menu Commands 

Keystroke 
Command Equivalent Menu 

Abandon "A File 
Bullets "K Options 
Delete Row "Y Edit 
Get Border ... "B Edit 
Insert Row "N Edit 

Lands~ape "L Options 
Lines & Boxes ... "Z Options 
New "W File 
Numbers & Letters "K Options 
Open ... "'0 File 

Portrait "'P Options 
Quit "'Q File 
Remember Template "'R Template 
Remove Border "F Edit 

Save "'V File 
Save as ... "'M File 
Shortcuts ... "C Options 

Template Gallery ... "'G Template 
To Output "U File 
Toolkit "'J Options 
Use Template from ... "'T Template 
Zone Markers "'J Options 
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SAVING YOUR WORDCHARTS 

You can use two File Menu commands to save your 
wordcharts: 

• Save as ... 
• Save 

The first time you save a wordchart, use the Save as ... 
command. The Item Selector appears so you can give the 
wordchart a name. 

By using the Save as ... command, you can also revise a 
wordchart and keep both the original and revised versions. 
For example, you can open an existing wordchart, make 
changes to it, and save the revised wordchart under a new 
name. Your original wordchart and the revised wordchart 
are both available on disk. 

Use the Save command for routinely saving your 
wordchart if you do not want to keep separate versions. 

If you choose the Save command and have not previously 
saved the wordchart on disk, the Item Selector appears 'so 
you can give your wordchart a name. . 

Note: When you choose the Save command, GEM 
WordChart leaves a version of your wordchart with the 
type BAK in your directory. See Appendix B, "Wordcharts 
with Type BAK," for a description of what these are and 
how you use them. 
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CHANGING COLOR WITH THE TOOLKIT 

[!JaDIl 
IIElall 

The toolkit uses numbered squares to show the 
colors available for your wordchart. If you can 
display colors with your GEM software, you see 
the actual colors in addition to the number 
codes. 

An outline surrounds the color number assigned to the 
active text zone. To change the color, click on the 
number for the color you want. 

If your computer cannot display colors, you can still 
assign colors codes to your text and then print or display 
your wordchart on a device (printer, plotter, screen, or 
camera) that can reproduce colors. The device translates 
the color codes to colors it can produce. 

Note that different devices may produce different colors 
from the same color code. For example, your screen may 
reproduce color code 3 as blue, but a color printer may 
reproduce it as green. To determine what colors are 
produced by your output devices, you can create a couple 
of sample wordcharts that use all of the available color 
codes and then reproduce them on each device. 

Color 0: a Special Case 
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Color 0 (zero) is white. If you enter text and then select 
color 0, it disappears from the screen, because the text 
and the GEM WordChart background are now the same 
color. 

However, if you place text with the color 0 attribute over a 
solid or patterned colored background, the result is white 
text on that solid or patterned background. You can 
create such a background when you create a border. (See 
"Creating Your Own Borders," later in this section.) 



GEM WordChart Changing Color with the Toolkit 

In this one case, what you see on the screen is not 
exactly what you get. On the GEM WordChart screen, the 
unused part of each text field appears as a solid or 
shaded white bar. If you send the wordchart to a printer 
or to the screen using the GEM OUTPUT program, the 
white bar goes away. 

Note: You cannot get this "white-on-black" effect with a 
plotter. Because of the way plotters work, they fill in the 
entire background, including the space to be occupied by 
the text. For more on plotters, see Appendix C, "A Note 
on Plotters." 
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ADDING BULLETS, NUMBERS, OR LETTERS 

0 0 0 

- • • 
0 1.1 ~L 
1- . I 1 

1. i 
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By selecting from the toolkit, you can highlight your text 
in the following ways: 

[) 

II-

1 . 

1 ) 

nI' 
t/ 

a. 

a) 

• You can mark your text fields with "bullets" 
(circles, squares, arrowheads, check marks, 
or a dash) . 

• You can make itemized lists by marking the 
text fields with arabic or roman numerals or 
with letters. 

The toolkit initially shows bullets. To change it to 
numbers and letters, choose the Numbers & Letters 
command from the Options Menu. To change back to 
bullets, choose the Bullets command. The command is 
always for the opposite of what is currently visible in the 
toolkit; that's how you get back and forth. 

A square outline surrounds the current setting. To add 
bullets, numbers, or letters, click on them with the pointer. 
To remove them, click on the empty box in the upper left. 

GEM WordChart places the bullets, numbers, or letters to 
the left of all text fields in the active text zone. 

Bullets, numbers, and letters always have the same color 
as the text in the zone. In addition, numbers and letters 
always have the same style (Normal, Bold, or Italic, but not 
Underline) as the text in the lone. 

GEM WordChart makes bullets, numbers, and letters 
proportional in size to the text in the lone. If you change 
the size of the text, GEM WordChart automatically changes 
the size of the bullets, numbers, or letters to match. 
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CHANGING FONTS 

I ~ Swiss 
. Dutch 

The toolkit shows you the font assigned to the 
active text zone. To change to a different font, 
click on the name of the font you want. 

GEM WordChart indicates the current font with a marker. 

CHANGING TEXT STYLE 

Norrilal 
~ Bold 
~ Italic 

Underline 

The toolkit shows the style of the text in the active 
text zone. GEM WordChart offers four text styles: 
Normal, Bold, Italic, and Underline. To change to a 
different text style, click on the style you want in the 
toolkit. 

GEM WordChart indicates the current text style with a 
marker. 

You can combine text styles to produce Bold Italic, Bold 
Underline, Italic Underline, or Bold Italic Underline. 

The Bold, Italic, and Underline settings are "toggles"; they 
switch back and forth between normal text and the style 
named. For example, if you have normal text and you 
click on Bold, the text becomes bold. If you click on Bold 
again, the text switches back to normal. 
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CHANGING TEXT SIZE 

14 
... 20 

28 
36 
72 

Point Sizes 
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The toolkit shows the size of the text in the active text 
zone. To change to a different text size, click on the size 
you want in the toolkit. 

GEM WordChart indicates the current text size with a 
marker. 

Traditionally, 72-point type is one inch high. The table 
below shows the approximate height of four typical point 
sizes. 

Point Size Measurements 

Point Size 

20 
28 
36 
72 

Vertical Height (in.) 

0.25 
0.4 
0.5 
1.0 

Note: Actual text height can vary from one output device 
to another. This is a function of the device, not GEM 
WordChart. You can see how type will appear in output 
by creating a test wordchart with each size of text. 
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CHANGING TEXT ALIGNMENT 

Left 
~ Center' 

Right 
Dechlal 

The toolkit shows you how text is aligned in the active 
text zone. To change the text alignment, click on the 
alignment you want. 

GEM WordChart indicates the current text alignment 
with a marker. 

Here are examples of Left, Center, and Right alignment: 

Left-aligned text lines up against 
the left margin of the zone. ~/)itt~{tttt 

Centered text is centered 
between the margins of the zone. 

Decimal Alignment 

Right-aligned text lines up against 
}}}{i}=i}(} the right margin of the zone. 

In decimal alignment, GEM WordChart aligns columns of 
numbers, including monetary amounts, at the decimal 
pOint. Decimal alignment is available only in the text body 
zone. 

In addition to the numerals 0 through 9 and blank spaces, 
the following characters are valid in decimally aligned 
columns: 

$ o 
-0 + 

No other characters, including the letters of the alphabet, 
are permitted. 
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ADDING LINES AND BOXES 
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You can highlight your text by placing boxes around it or 
by placing lines above it, below it, or above and below it. 
When you choose the Lines & Boxes command from the 
Options Menu, GEM WordChart displays the following 
dialog: 

Boxes 

Lines 

Line Length 

Thickness 

Lines & Boxes 

Yes II No 

Above II Be 1m., 

Hatch Fie 1d II Hatch Text 1 

--11--11--11--

OK I CANCEL I 

To add boxes or lines, first select the zone in which you 
want them to appear. Then choose the Lines & Boxes 
command to display the dialog. 

To place boxes around the text, take the following steps: 

1. Click on Yes in the Boxes line. 
2. Click on one of the four available outline thicknesses. 
3. Click on the OK button. 
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To place lines above or below your text, do the following: 

1. Click on Above or Below, or both. 

2. Click on Match Field or Match Text. 

Match Field lines extend the full length of the fields, 
regardless of the length of the text in them. 

Match Text lines are only as long as the text in the 
fields. 

3. Click on one of the four available line thicknesses. 

4. Click on the OK button. 

If you select the Match Text option, keep the following in 
mind: 

• There must be text in the fields before you can add 
Match Text lines. 

• If the text in the field "wraps" (is more than one line 
long), the highlight line is as long as the longest line 
of text in the field. 

Removing Lines or Boxes 

To remove boxes or lines, first select the zone from which 
you want to remove them. Then choose the Lines & 
Boxes command to display the dialog. 

To remove boxes, simply click on No in the Boxes line and 
then click on the OK button. 

To remove lines from your text, do the following: 

1. Click on the highlighted button (or buttons) you want 
to "turn off": Above, Below, or both. 

2. Click on the OK button. 
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PORTRAIT AND LANDSCAPE FORMATS 

Portrait and Landscape refer to how your wordchart 
appears on the screen, page, or transparency. As the 
illustration shows, Portrait is a vertical format and 
Landscape is a horizontal format. 

PORTRAIT 

::::::::::::::::::;:;:::::::::::::::::::::::;::::::'" ................ . :':':::::';':':::':':':':':':':':':':':';':';'::;:::::::::;::':':':':':':'::;:::::::;:::::;:::::::::;:;:::;:::::::::;:;:;:::;: 
;:;:;:;:;:;:;:;:;:;:;:::;:;:;:::;:::;:;:;:::;:;:;:;:;:;:::;:;:;:;:;:::::::;:;:;:;:::::;:;:::;:;:::;:;:::::;:;:;:::::::;:;:;::: 
:;:;:;:;:;:;:;:;:;:;:;:;:;:::;:;:::;:;:;:;:;:;:;:;:::;:;:;:::;:;:;:;:;:::;:;:;:;:;:;:;:;:;:;:::;:;:;:::;:;:;:;:;:;:;:;:;:;:;:; 

;:;.;.;.;:;.;.;.;.;.;';:;:::,';';:;',';::':;' .... ;.:: ..... : .... ;.; ............ ; .... :.:-........ . ;:::::;:;:::;:::;:;:;:;:::;:::;:;:;:;:;:;:;:;:;:;:::::::::;:::;:;:::;:;:;:::;:::;:::;:;:;:;:;:;:;:;:;:;:;:;:;:::;:;:;:::;:;::: 
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::;:::;:;:;:::;:;:;:;:;:;:;:;:;:;:;:;:;:;:;:;:::;:;:;:;:;:;:;:::;:;:;:;:;:;:;:::::;:;:::;:::;:::;:;:;:;:;:;:;:;:;:;:;:;:;:;:;: 

;.;.:.;.:.;.;.;.;.;.;.;.;.;.;.;.;:;":;:;:;:;:;:;:;::;:;:;:;:;:;: ,.:.:-:.:-:;:::.:::.:.:-:;::::::: 
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The initial format for a new wordchart is Landscape. To 
change from Landscape to Portrait, choose the Portrait 
command from the Options Menu. To change from 
Portrait to Landscape, choose the Landscape command. A 
marker appears in the menu to the left of your current 
choice. 



GEM WordChart Using the Zone Markers 

USING THE ZONE MARKERS 

When you choose the Zone Markers command 
from the Options Menu, GEM WordChart 
replaces the toolkit with the zone markers, 
horizontal lines that define the upper and lower 
boundaries of each text zone. 

Each zone marker has a triangle at its midpoint. 
By dragging one of these triangles, you can 
change the size of the text zone. Changing a 
zone's size changes the amount of space above 
and below the text rows in the zone; it doesn't 
change the text rows themselves. 

As you change a text zone's size, you do a 
couple of things: 

• If you make the zone larger, you increase the amount 
of space between or around text rows in the zone. 
You 'can use this extra space for adding text rows with 
the Insert Row command. 

If you make the zone smaller, you decrease the 
amount of space between or around text rows. By 
making one zone smaller, you also leave room to 
enlarge the adjacent zone. 

• In either case, you move the zone's text rows up or 
down. 

Text rows are always evenly spaced between their top and 
bottom zone markers. If you change the size of the zone, 
the text rows reposition themselves to retain this even 
spacing. 
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You can use the zone markers to move text rows on the 
page. For example, if you want the title closer to the 
column head, drag the title's top zone marker down. 

Note: When moving the zone markers, place the tip of the 
pointer directly on top of one of the triangles, and press 
the mouse button. Don't begin dragging until the pointing 
finger icon appears (see left). 

Changing Adjacent Zones Simultaneously 

Adjacent zone markers are actually two separate lines. 
For example, although the bottom marker of the title zone 
and the top marker of the column head initially appear to 
be a single line, you can drag them separately. 

However, if you want to move adjacent zone markers 
together, hold down the Shift key as you drag. 

For example, if you Shift-drag the title zone's bottom 
marker triangle, you, move both the bottom marker and the 
column head's top marker. In this way, you can make one 
zone larger and the other smaller at the same time. 

Getting the Toolkit Back 
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To restore the toolkit to the screen, display the Options 
Menu and choose the Toolkit command. Like the Bullets 
and Numbers & Letters commands, the Zone Markers 
and Toolkit commands always represent the opposite of 
what is currently on the screen. Again, that's how you get 
back and forth. 



GEM WordChart Templates 

TEMPLATES 

Templates are a feature of GEM WordChart that make it 
quick and easy to use. Without templates, you would 
have to design each new wordchart from scratch. With 
templates, you simply choose one, and GEM WordChart 
knows exactly how you want your wordchart to look. 

There are two places from which you can choose a 
template: 

• template gallery 

The template gallery is part of your GEM WordChart 
software. It contains several standard templates. You 
can modify the templates in your template gallery to 
make them more suited to your own specific needs, or 
you can use them just as they are. 

• existing wordcharts 

Every time you store a wordchart on disk, you also 
store its template, which you can use to create other 
wordcharts. 

USing the Template Gallery 

When you choose the Template Gallery ... command from 
the Template Menu, a dialog appears on your screen. The 
icons in the dialog represent the templates currently 
available in your template gallery. The illustration on the 
next page shows the template gallery dialog. 
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Template Gallery 

EI~""" ~ ...... ~ ...... ~ ...... 
Colurrmar: _ ~~~ §:~~§ ~~~~~ 

.......... .......... .......... . ........ . 

~ ~ r====l Outline: ~ ~ ~ 

F pee- foprrl : I .. ::-::... I 
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OK CANCEL 

The icon for the template now on your screen is 
highlighted with a dark background; it is your "current" 
template. To use a different template, click on the one 
you want and then click on the OK button. 

Caution: Changing from a multi-column template to one 
with fewer columns causes you to lose columns and any 
text in them. For example, if you change from a four
column template to a two-column template, the two 
columns on the right are lost. If you want to keep the 
four-column version, save it before you change templates. 

The template gallery offers choices from three types of 
templates: 

• columnar 
• outline 
• free-form 

You have already worked with the single-column template 
in the tutorial. The multi-column, free-form, and outline 
templates offer you additional flexibility in creating 
wordcharts. 
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Using Multi-Column Templates 

When you move the cursor to the column heads or text 
body of a multi-column template, you activate the column 
in which the cursor is located, not the entire zone. Note 
the position of the select boxes in the illustration: 

o 0 

• Left-aligned Centered text. 326.021 
text 

• Bold style. Normal style. 16.597833 

• Swiss font. Dutch font. 

• 
o o 

You can give each column its own text style, font, 
alignment, color, or bullets. However, the text size you 
choose applies to all columns. 

In a multi-column template you can move the cursor with 
the keyboard in the following ways: 

• Use the up-arrow, down-arrow, Enter key, and the 
Ctrl-E and Ctrl-X keystrokes to move the cursor up or 
down within the same column. 

• Use the Tab key to move the cursor to the next 
column and Shift-Tab to move the cursor to the 
previous column. 

• Use the right-arrow or Ctrl-D to move the cursor one 
character to the right. Use the left-arrow or Ctrl-S to 
move the cursor one character to the left. If there is 
no character to the right or left, the cursor moves to 
the next or previous column. 
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Using the Free-Form Template 
At first glance, the free-form template looks just like the 
single-column template. What sets the free-form 
template apart is the fact that it is made up of text fields 
you can select individually, and whose attributes you can 
change individually. 

When you move the cursor to any field in the free-form 
template, you select that field only. You can change the 
field's attributes without affecting the attributes of any 
other fields (although changing text size does affect the 
spacing between fields in the same zone). 

Using the Outline Templates 
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GEM WordChart includes three templates for preparing 
outlines: a two-level outline, a three-level outline, and a 
four-level outline. 

The outline templates each have only three text zones: 
title, text body, and footer. 

In the text body of each outline template, there is a major 
entry ("A" in the illustration on the next page) followed by 
one or more levels of progressively indented subentries 
("8," "C," and "0.") In each template the lowest-level 
subentry appears twice. These major entry-subentry 
groups are repeated as many times as will fit in the text 
body zone. 

The illustration on the next page shows how the major 
entry and subentries are arranged in the three outline 
templates. 
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two-level outline three-level outline four-level outline 

The rules for selecting and inserting rows in the text body 
of an outline template are different from the rules that 
apply to the columnar templates. 

• When you move the cursor to a row in the text body, 
you only select the rows at the same level as the one 
in which the cursor is located; you don't select the 
entire text body. In addition, any changes you make in 
the toolkit affect those rows only. 

For example, if you move the cursor to any B-Ievel 
row, you select the B-Ievel rows only (as the position 
of the select boxes indicates). If you change a text 
attribute, you only change it in the B-Ievel rows. 

• When you use the Insert Row command, GEM 
WordChart inserts an empty row of the same level as 
the one in which the cursor is located, plus any lower
leverrows. The new rows are inserted immediately 
above the row in which the cursor is located. 

For example, if the cursor is in row B of a three-level 
outline, GEM WordChart inserts a B-Ievel row and two 
C-Ievel rows. If the cursor is in row B of a four-level 
outline, GEM WordChart inserts a B-Ievel row, a C
level row, and two D-Ievel rows. 
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Changing Your Template Gallery 
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If you wish, you can make a modified template a 
permanent part of the gallery. 

Note: THE FOLLOWING STEPS CAN CAUSE A PERMANENT 
CHANGE TO YOUR TEMPLATE GALLERY. You can use 
these steps for practice and familiarization, but skip Step 6 
(the Remember Template command) until you really want 
to change your template gallery. We recommend you use 
GEM WordChart for a while before making such changes. 

1. Display the Template Menu and choose the Template 
Gallery ... command. 

2. In the template gallery, click on the icon for the 
template most like what you ultimately want. For 
example, if you want to keep a modified version of the 
three-column template, click on the three-column icon. _ 

3. Click on the OK button. The template gallery 
disappears; the new template appears on the screen. 

4. Modify and fill in the template to create your 
wordchart. 

5. - Use the Save as ... command to name and save your 
wordchart. 

6. DO THIS STEP ONLY IF YOU WANT TO MAKE A 
PERMANENT CHANGE IN YOUR TEMPLATE GALLERY. 
Display the Template Menu and choose the Remember 
Template command. GEM WordChart replaces the 
current template in the gallery with the template now 
on your screen. 

Note: Although the Remember Template command 
changes the templates in the gallery, it does not change 
the icons in the template gallery dialog. Don't be alarmed 
if, the next time you see the template gallery dialog, it 
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looks just the same. If you used the Remember Template 
command, your modified template is part of the gallery. 

If you plan to change the gallery but still want the original 
templates to be available, you can create "dummy" 
wordcharts using the templates in your origi.nal template 
gallery. This way, you can always use the original 
templates with the Use Template from ... command. 

Restoring the Original Template Gallery 

If you want to discard all changes you have made to the 
template gallery and restore the original set of templates 
that came with GEM WordChart, do the following: 

1. Quit GEM WordChart and return to the GEM Desktop. 

2. Find the GEMAPPS folder (you might have to open 
folders and/or close directories) and open it. 

3. Find document icons called DEFAUL TP.WCT or 
DEFAUL TL.WCT in the GEMAPPS folder window. 

4. To restore the original Portrait format template gallery, 
delete DEFAUL TP.WCT. 

To restore the original Landscape format template 
gallery, delete DEFAUL TL.WCT. 

5. Restart GEM WordChart. 

When you select templates from the gallery now, you'll 
get the original set, not the modified templates. 

The modified templates are still available, however, as 
long as you have saved at least one wordchart using each 
modification. To use these templates, use the Use 
Template from ... command, described next. 
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Using the Template from Another Wordchart 
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The Use Template from ... command lets you use the 
template (minus text) of any existing wordchart to create a 
new wordchart. The Use Template from... command is 
available only if there is no text in the template currently 
on your screen. (To clear the text from the screen, save 
any changes you want to keep and then choose the New 
command from the File Menu.) 

When you choose Use Template from ... , the Item Selector 
appears on your screen so you can select the wordchart 
whose template you want to use. (Section 5 describes 
how you use the Item Selector.) 

If you make regular wordchart presentations and want to 
present a consistent style, the Use Template from ... 
command is particularly useful. You can create sets of 
wordcharts that match in general appearance but have 
different text content. After you create your first set of 
wordcharts, simply use the templates from that set to 
create any subsequent presentations. 

The template you use retains the following from the saved 
wordchart: 

• number of text rows 
• margin settings for each text zone 
• all attributes from the toolkit, including bullets 
• border (if any) 
• any lines or boxes in the text zones 
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BORDERS 

GEM WordChart includes several borders you can add to 
your wordcharts. The borders are stored in the BORDERS 
folder, which is itself inside the GEMAPPS folder. All 
border names end in -P or -l (for Portrait and landscape) 
and have the GEM type. For example, lOGO-P.GEM 
identifies a Portrait-type border; CRT -l.GEM identifies a 
landscape-type border. 

Note: Only use a border whose format (Portrait or 
landscape) matches the format of your wordchart 
template. 

Hint: To help you select borders, you can create sample 
wordcharts using each of the available borders. You can 
print the wordcharts, label them with the names of the 
borders you used, and store them for future reference. 

Adding a Border 

It's a good idea to add the border before you enter any 
text in the wordchart, because GEM WordChart 
automatically adjusts an empty template to fit a border. If 
you add a border to a wordchart that already contains 
text, you might have to modify the wordchart to fit the 
border, as described later. 

To add a border, choose the Get Border ... command from 
the Edit Menu. When the Item Selector appears, double
click on the name of the border you want. If necessary, 
scroll the window containing the list of border names until 
the name you want comes into view. (See Section 5 for 
more instructions on how to use the Item Selector.) 
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Removing a Border 

To remove a border, choose the Remove Border 
command from the Edit Menu. 

When you remove a border, GEM WordChart automatically 
adjusts the template to fit the available space on the 
screen. 

Creating Your Own Borders 
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You can create your own borders for use with GEM 
WordChart if you have GEM Draw from Digital Research. 

When you use GEM Draw to create a border for a 
wordchart, you must keep two important facts in mind: 

• The GEM Draw border you create must have a 
document size (file size) of 4000 (4K) bytes or less. 
This size depends on the complexity of the drawing-
the number and type of picture elements used. You 
can use the GEM Desktop's Info/Rename ... command 
(Show info ... in some versions of the GEM Desktop) to 
learn the size of a border document. 

• GEM WordChart looks for an invisible "locator 
rectangle" in each GEM Draw border document. This 
rectangle tells GEM WordChart where to place the 
wordchart text inside the border. 

Here's a typical sequence for creating a border in GEM 
Draw: 

1. Open the BORDERS folder and double-click on any 
border docl1ment icon in the window. This starts GEM 
Draw. 
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2. When the GEM Draw screen appears (there will be a 
border design in it), immediately choose the New 
command from the File Menu. This clears the existing 
border off the screen and lets you start a new one. 

The main reason for starting GEM Draw this way is 
that, when you save your new border design, you don't 
have to take any special steps to make sure it ends up 
in the BORDERS folder. 

3. Draw the visible portion of the border using circles, 
rectangles, lines, or text--whatever you want. 

Make sure you use the full page when drawing the 
border. Otherwise, the border will probably be too 
small for your wordchart's text. 

4. When the visible border is finished, add the locator 
rectangle. The rectangle's appearance (fill pattern, etc.) 
is not important right now. What is important is where 
you put it, since its location determines the placement 
of the wordchart text inside the border. 

5. With the rectangle still the current element, do the 
following: 

• Display the Color Menu and choose color 0 (zero). 

• Display the Alignment Menu and choose the Put in 
Back command. (This is essential. The locator 
rectangle must be the first element in the border.) 

6. Name and save the border document. 

Note: In some versions of GEM Draw, the Alignment Menu 
is called the Arrange Menu. 
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Adding a Colored Background 

If you want to create a wordchart with white text on a 
shaded or colored background (see "Color 0: a Special 
Case" earlier in this section), you must make the 
background part of your border document. 

To add a background, create the border as just described 
and include the background in step 3. For example, you 
could include a solid rectangle at this point. When adding 
the locator rectangle, be sure to keep in mind the 
relationship of the text to the background. 

In this case, add the border after you finish entering the 
text in the template. If you add the border first, entering 
and editing text can make parts of the background seem 
to disappear. (They haven't disappeared, as you will see if 
you print your wordchart, but this effect can be 
disconcerting.) 

Modifying a Wordchart to Fit a Border 
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If you try to add a border to a wordchart that already 
contains text, you might find the wordchart won't fit in the 
border. In that event, GEM WordChart displays an alert 
message telling you the wordchart is too big for the 
border. 

To fit the wordchart into the border, you can try any or all 
of the following: 

• Use wider margins. 

• Use a smaller type size. 

• Use the zone markers (described earlier in this section) 
to "compress" the wordchart into a smaller area. 

End of Section 4 
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Item Selector 

The Item Selector is a special dialog that appears on your 
screen when you choose commands to do any of the 
following: 

• open (recall) an existing wordchart 
• name and save a wordchart 
• include a border in your wordchart 
• use the template from an existing wordchart 

The following commands cause the Item Selector to 
appear: 

• Open ... 
• Save as ... 
• Get Border ... 
• Use Template from ... 

The illustration on the next page shows the Item Selector 
and its components. 
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ITEM SELECTOR COMPONENTS 

close box Directory line Selection line 

ITH1 SELECTOR 

Directory: C : \"~CHARTS\ * . "ICH 

I 
~ 

-~ ~J *.ING Selection: -
ACCOUN T 1 . "ICH .... 

ACCOUNT2 . ~ICH r--
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EAST . "}CH 
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NORTH .\'}CH 

I I SA L ESDP T . "ICH. 7: 
OK 

SlIDESHO .~ICH 
STRATEGY.WCH 

~ I Cancel I 
.... 

directory window 

DIRECTORY LINE 

The Directory line tells where the items listed in the 
directory window are located. The information in the 
Directory line is cal'ed a "directory path." The table on the 
next page shows how you read a Directory line. 
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Directory Line 

A:\WCHARTS\*.WCH 

Directory Lines 

What It Means 

all documents with type WCH in a 
folder called WCHARTS on drive A 

C:\GEMAPPS\BORDERS\*.GEM all documents with type GEM in a 
folder called BORDERS, which is itself 
inside the GEMAPPS folder on drive C 

The asterisk (*) "wildcard" character takes the place of 
your documents' names. For example, *.WCH means "all 
documents with type WCH." 

For more information on directory paths, see your GEM 
Desktop manual. 

DIRECTORY WINDOW 

The directory window lists the items that are in the 
directory named on the Directory line. The window can 
only show nine item names at a time. Use the scroll bar, 
arrows, and slider to move up and down in the directory if 
it contains more than nine items. 

CHANGING THE DIRECTORY PATH 

By changing the directory path, you can do either of the 
following: 

• Specify a different directory (folder) in which to store 
an item. 

• Specify a different directory (folder) from which to 
open an item. 
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You can change the directory path with the mouse or by 
editing the Directory line. 

Using the Mouse 

To use the mouse to move down the directory path (in 
other words, to see what's in a folder currently listed in 
the directory window), click on the folder's name. Folders 
are identified by diamonds next to their names. 

For example, if the Directory line reads C:\GEMAPPS\*.GEM 
and you click on the folder name BORDERS in the 
directory window, this is what happens: 

• The Directory line reads C:\GEMAPPS\BORDERS\*.GEM. 

• The directory window lists all items with the GEM type 
in the BORDERS folder. 

To use the mouse to move !!Q a level in the directory path 
(toward the root directory), click on the directory window's 
close box. For example, if the Directory line reads 
C:\GEMAPPS\BORDERS\*.GEM when you click on the close 
box, this is what happens: 

• The Directory line changes to C:\GEMAPPS\*.GEM. 

• The directory window lists all items with the GEM type 
in the GEMAPPS folder. 

Editing the Directory Line 
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Using the GEM Desktop dialog editing keys (Ieft- and 
right-arrow, Backspace, Del, and Esc), you can change the 
directory path in the Directory line. 
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After you change the Directory line, you must update the 
directory window to list the contents of the folder you 
named. To update the directory window, do either of the 
following: 

• Click inside the directory window. 
• Press the Enter key. 

SELECTION LINE 

The Selection line is where you type the name of a 
wordchart you are storing on disk and where you enter 
the name of a wordchart or border you want to recall 
from disk. 

NAMING AND SAVING FOR THE FIRST TIME 

Unless you want to save your wordchart to a folder other 
than WCHARTS, naming and saving for the first time 
requires just three steps: 

1. When you are ready to save your wordchart, choose 
the Save as ... command from the File Menu. 

2. When the Item Selector appears, simply type the name 
of your wordchart in the Selection line. You don't 
have to type WCH; GEM WordChart supplies it 
automatically. 

3. Click on the Item Selector's OK button. 

If you want to save the wordchart to another folder, 
change the directory path with the mouse or by editing 
the Directory line before entering the wordchart's name in 
the Selection line. 
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OPENING A WORDCHART 

To open a wordchart, choose the Open ... command and 
then do any of the following: 

• Double-click on the wordchart's name in the directory 
window. This is the fastest method. 

• Click on the wordchart's name in the directory window. 
GEM WordChart inserts the name in the Selection line. 
Click on the OK button or press the Enter key. 

• Type the wordchart's name on the Selection line, then 
click on the OK button or press the Enter key. 

USING A WORDCHART TEMPLATE 

To use the template from another wordchart, choose the 
Use Template from ... command. When the Item Selector 
appears, select the wordchart name. The techniques are 
the same as for opening a wordchart. 

INCLUDING A BORDER 

5-6 

To include a border in your wordchart, choose the Get 
Border ... command. When the Item Selector appears, 
select the border name. The techniques are the same as 
for opening a wordchart. 

End of Section 5 
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APPENDIX A 

Modifying Wordcharts with 
GEM Draw 

If you have GEM Draw, you can use it to modify your 
wordcharts. For example, you might want a wordchart 
with an organizational chart in the middle of it, as in the 
illustration below. 

VENTUREX, INC. 
Corporate Structure 

Edgar Fellows, President & 
ChIef Executive Officer 

Morris Blumenthal, Senior 
Market Analyst 

I 
I 
I 

Mary Patterson, VP
Purchasing 

Jo Davidian, Personnel 

Fiscal Year 1985-86 
Roberta Mendoza, Senior VP 

Sadao "Jack" Akiyoshi, VP
Marketing 

J. Davidian B. Lumley 

Fred Wendell Washington, 
VP-Product Development 

Bill Lumley, Facilities & 
Maintenance 
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With GEM Draw, you can make the following changes to 
your wordcharts: 

• You can move individual text fields on the page. 

• You can change the attributes of the text in each field. 

• You can do anything else that GEM Draw allows, 
including modify your border, add text, or add pictures 
in the middle of the wordchart. 

To create the wordchart illustrated on the previous page, 
take the following steps: 

1. Create and save the basic wordchart. 

2. Quit GEM WordChart. 

3. Open the WCHARTS folder and find the icons for the 
wordchart you just saved. 

Double-click on the icon with the GEM type. This 
starts GEM Draw with your wordchart on the screen. 

4. Use GEM Draw to create the organizational chart. 

You might need to group and move blocks of text to 
make room for the organizational chart. 

In addition, you can group, move, or align the 
wordchart text and/or the GEM Draw picture to arrange 
everything on the page. 

5. Save the modified wordchart. 



GEM WordChart Modifying Wordcharts with GEM Draw 

Note: Once you h,ave saved it, you can only work on the 
modified version in GEM Draw. You cannot bring it back 
into GEM WordChart. For this reason, when you save the 
modified wordchart, we suggest you do the following: 

• Use the Save as ... command and give the modified 
wordchart a new name. This will help you avoid 
confusion with the GEM WordChart original. 

When you use the Save as ... command in GEM Draw, 
the original WCH and GEM documents from GEM 
WordChart are unaffected. 

• Save it in a folder other than WCHARTS. A likely 
candidate is the folder with your other GEM Draw 
documents. 

To do this, you will have to change the directory path 
in the Item Selector, as described in Section 5. 

End of Appendix A 
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APPENDIX B 

Wordcharts with Type BAK 

o 

When you edit an existing wordchart (Jet's call it 
SLiDESHO) and then use the Save command to save it, 
GEM WordChart does the following: 

• It saves the new versions of SLiDESHO.WCH and 
SLIDESHO.GEM. 

• It places a generic document icon called SLiDESHO.BAK 
in your WCHARTS folder. 

SLIDESHO.BAK 

SLIDESHO.BAK is actually the previously saved version of 
SLiDESHO, the version you had when you began editing. 
GEM WordChart saves it as SLiDESHO.BAK in case you 
decide you need the older version. 

If you don't want SLIDESHO.BAK, you can delete it. 

If you want to use SLIDESHO.BAK with GEM WordChart, 
you must rename it and change its type to WCH, and you 
must create a matching version with type GEM for use 
with GEM Output and GEM Draw. Here's what you do: 

1. In the WCHARTS folder on the GEM Desktop, select the 
SLiDESHO.BAK icon and rename it to something with 
type WCH--SLlDE2.WCH, perhaps. 

2. Double-click on SLlDE2.WCH to start GEM WordChart. 

3. When SLlDE2.WCH appears on your screen, 
immediately choose the Save command. 

B-1 
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4. A dialog appears, asking if you want to replace the 
existing SLlDE2.WCH .. Click on the Replace button. 

The WCHARTS folder now contains SLlDE2.WCH and 
SLlDE2.GEM, and you can treat them as you would any 
other wordchart documents. Because you used the Save 
command, the folder also contains SLlDE2.BAK, which 
you'll probably want to delete. 

End of Appendix B 



Appendix C 

A NOTE 

ON PLOTTERS 





APPENDIX C 

A Note on Plotters 

Under certain circumstances, a plotter--unlike a printer, 
screen output device, or camera--cannot accurately 
reproduce your wordcharts. Here are some of the 
limitations of plotters: 

• Each picture or wordchart is made up of a number of 
elements: circles, squares, lines of text, etc. A plotter 
always draws each element completely. This can 
produce problems. 

Let's say you want red text in a blue square. Because 
a plotter draws the entire blue square (it doesn't leave 
out the area to be occupied by the text), the red ink of 
the text goes directly on top of the blue, rather than in 
place of it. 

• A plotter can only reproduce solid fill, cross hatching, 
and vertical, horizontal, and diagonal line fills; it cannot 
reproduce the other fill patterns available in an 
application like GEM Draw. 

• A plotter doesn't pick up a pen when asked for color 0 
(zero). As a result, you can't produce the white text on 
dark background that you can with a printer. 

• Finally, the GEM "plotter drivers" (the special programs 
by which GEM Output transmits data to your plotter) 
do not include fonts. Most plotters include fonts as 
part of their internal software, but these fonts might 
not match what you see on the screen. 

End of Appendix C 
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Free-form template, 4-24 

G 

GEM Draw, 4-30, 4-31 
modifying wordcharts with, 

A-1 
GEM OUTPUT, 3-7, 4-11 
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Keyboard control diamond, 2-6 
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size, 4-12 
style, 4-12 
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Outline templates, 4-24 
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selecting rows, 4-25 
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Portrait command, 4-5, 4-18 
Portrait format, 4-18 
Printing wordcharts, 3-7 
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Quit command, 3-10, 4-2 

R 

Remember Template command, 
4-4,4-26 

Remove Border command, 3-9, 
4-3, 4-30 

Removing borders, 4-30 
Restoring original template 

gallery, 4-27 
Rows 

See "Text rows" 
Ruler, 2-3 

S 

Save as ... command, 4-2, 3-4, 
3-7, 4-9, 5-1 

Save command, 4-2, 4-9, B-1 
Saving new version of 
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Saving wordcharts, 3-4, 4-9, 
5-5 

Scroll bar, 2-7 
Select boxes, 2-4 
Selecting rows in outlines, 4-25 
Selecting text zones, 2-5 
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Shift key 
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Shift-Delete, 3-5 
Shift-drag, 4-20 
Shift-Tab, 2-5, 4-23 
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Shortcuts ... command, 3-5, 4-5 
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Desktop), 4-30 
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START OUTPUT dialog, 3-8 
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floppy disks, 1-4 
hard disk, 1-4 

Tab key, 2-5, 4-23 
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Template gallery, 4-21, 4-22 
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changing, 4-13 
toggles, 4-13 

Text zones, 2-3 
active zone, 2-4 
attributes, 2-3 
changing size, 4-19 
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color, 4-10 
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fonts, 4-13 
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Underline text style, 4-13 
Updating directory window, 5-5 
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WCH type, 1-5, 2-3, 3-4 
WCHARTS folder, 1-3 
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WordChart info ... command, 

4-6 
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Wordchart type, 2-3 
Wordcharts 

adding borders, 4-29 
changing margins to fit 

border, 4-32 
changing text size to fit 

border, 4-32 
creating borders, 4-30 
formats, 4-18 
keeping separate versions, 4-9 
modifying to fit border, 4-32 
modifying with GEM Draw, 
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moving with scroll bar, 2-7 
moving with slider, 2-7 
naming, 4-9, 5-5 
opening, 5-6 
printing, 3-7 

removing borders, 4-30 
saving, 3-4, 4-9, 5-5, A-3 
saving new version, 3-7 
using zone markers to fit 

border, 4-32 
WORDCHRT Menu, 4-1, 4-6 
WORDCHRT.APP, 1-3, 1-4 
Wrap, 3-3 
WRDCHTHI.RSC, 1-3 
WRDCHTLO.RSC, 1-3 
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Zone markers, 2-6, 4-19 
moving zones, 4-19 

Zone Markers command, 4-5, 
4-19 

Zones 
See "Text zones" 
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